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MacWise Version 23 User's Manual
You can use Command F to find what you are looking for in this document.

Introduction
Terminal Emulation
MacWise emulates ADDS Viewpoint, Wyse 50, Wyse 60, Wyse 370, Televideo TV 925,
DEC VT100, VT220 and Prism terminals. Supports ANSI color. Esprit III color is also
supported in Wyse 370 mode.
MacWise allows a Macintosh to be used as a terminal -- connected to a host computer
directly, by modem, or over the Internet. The emulators support video attributes such
as dim, reverse, underline, 132-column modes, protected fields and graphic
characters sent from the host computer, as well as enhanced Viewpoint mode.
Features include phone list and dialer for modems, on-screen programmable function
keys, connection scripts and more.
Connectivity
1. Built in Modem
2. Telnet / TCP/IP
3. SSH Secure Shell
4. Serial ports via USB to Serial adaptor .
5. Also communicates directly with the Mac unix shell
—————————————————————————————————————————————————————
————————————————————————————

Telnet

Telnet settings are under the Connection Menu.
Select "Telnet" to enable telnet.
Select "Telnet Connection..." to enter your Host IP address, port number and terminal
type.

=============================== KERMIT
================================
NOTE: If you are running Mac OS 10.13 or later, you need to also use Kermit.
(There should be a check mark on "Kermit" under the Connection Menu.)
Kermit is installed automatically when Mac OS 10.13 or later is detected.
You can re-install kermit any time by selecting Kermit Installer from the Help Menu in
MacWise.
Echo Kermit Characters ( under the Connection Menu )
This is normally enabled when Kermit is enabled.
If you get double characters when typing, then uncheck this option.
Use SLnet options with Kermit ( under the Connection Menu )
Enable this option if you are using Kermit to make a telnet connection and cannot
connect to your host.
If this option is not enabled, you may get the following errors trying to connect:
Negotiations...
The Telnet server is not sending required responses
Telnet waiting for response to WILL KERMIT
Telnet waiting for response to DO KERMIT
NOTE: USE SLnet options with Kermit can cause problems with fkeys and arrow keys
when using VT100 or VT220 emulation.
It can also cause problems when clicking the mouse to send the column and row to
the host.
==================================================================
=======
The option for "Verbose Login" lets you see all of the commands during the login
process.
It is useful for troubleshooting login problems.
Use TC Shell to Log in - is an option that gives you a unix prompt after your
connection closes.
This is handy for system administrators but not so good for average users. If you are a
system administrator and do not want your users to be able to type commands into
the unix shell, then do not enable this option. However, some host computers will
require that this option is enabled and will not see the Terminal Type you have
entered if it is unchecked.
NOTE: When you uncheck this item, it also un-checks Unix Raw Mode. You can turn
Unix Raw Mode back on, but some hosts will not let you log in with this combination.
Unix Raw Mode - This is normally unchecked.
If you get a login message from the host but cannot type anything, uncheck this

option. If you get double characters when you type, check this option.
Kermit Data transfers will not work with Unix Raw Mode enabled. If you select Kermit
from the Emulate Menu, Unix Raw Mode will become unchecked.
You can enter telnet options also. Don't enter anything unless you know what you are
doing.
Click on options help to see a list of the commands you can use.
MacWise uses the Mac OS X unix shell to get a telnet connection.
Basically, if you already have a connection to your host from your Mac via ethernet or
the Internet, you should not need to change any other Mac settings to get a telnet
login.
Just select Open Connection from the Connection menu to get a login to the telnet
host.
Or you can just hit return.
If you cannot get a connection, take a look at your settings in the Network System
Preferences.
Click on the TCP/IP tab to check your settings.
Saving Settings for More than one Host Computer Connection
You can save your settings (under the File menu). This is valuable if you connect to
multiple host computers.
Then when you want to open a settings file you can select Open Settings from the File
Menu or you can double click on a settings file from the desktop.
HINT: Save all of your settings files in one folder. Save one settings file for each host
you connect to. Then you can easily choose from the list of hosts to connect to and
just double click on the one you want. Each settings file you double click on will open
a new window with all of the associated settings for that host.
Terminal Types
When you login to the Mac Unix Shell, MacWise will set your unix TERM type based
upon the emulation you have selected under the Emulate Menu. When you login with
telnet or secure shell, you can enter the TERM type or optionally leave it blank. If you
leave the TERM type blank, MacWise will use the following default term types:
Emulation
Prism
TV925
VT100
VT220
Viewpoint
Wyse 50
Wyse 60
Wyse 370

TERM type
prism7
tvi925
vt100
vt220
viewpoint
wy50
wy60
wy370

When you login to a host with telnet or secure shell, it is important to use the correct
TERM type.
If the host system administrator wants you to use a special name for your terminal,
then use that name. Otherwise just leave it blank and MacWise will use the standard
types above.
—————————————————————————————————————————————————————
————————————————————————————

SSH Secure Shell

Secure Shell settings are under the Connection Menu.
Select "Secure Shell" to enable secure shell logins.
Select "Secure Shell Connection..." to enter your Host IP address (or name), user
name, port number and terminal type.
The option for "Verbose Login" lets you see all of the commands during the login
process.
It is useful for troubleshooting login problems.
Unix Raw Mode - This is normally unchecked.
If you get a login message from the host but cannot type anything, uncheck this
option. If you get double characters when you type, check this option.
MacWise uses the Mac OS X unix shell to get a secure shell connection.
Basically, if you already have a connection to your host from your Mac via ethernet or
the Internet, you should not need to change any other Mac settings to get a secure
shell login.
Just select Open Connection from the Connection menu to get a login to the secure
host.
Or you can just hit return.
Port 22 is the default port for secure logins.
Mac OS X negotiates with the host computer for the best possible secure connection
and protocol.
If you want to add your own settings, you can enter options to change the way the
connection is made.
Click on the Options Help button to see what options you can use (in the Secure Shell
Connection window).
—————————————————————————————————————————————————————
————————————————————————————

Login to the Mac Unix Shell
You can log directly into your Mac unix shell.
You have the power to control many aspects of your Mac at this level.

Proceed with caution.
As of MacWise version 20.3.1 , the zsh shell is used.
There is no longer a choice for the tc shell or bash shell.
Only the zsh shell is reliable beginning with MacOS Big Sur.
The Mac Unix Shell Connection.. selection has been removed because that
contained options that are no longer used.
—————————————————————————————————————————————————————
————————————————————————————

Serial Connections

To set up your serial connection, simply pull down the Settings Menu and select your
Serial port, baud rate etc. Serial ports are automatically detected. New ports will
show up in the Serial Port Menu under Settings when you add more ports. Mac OS X
only supports the built in modem and USB serial ports. Therefore, MacWise cannot
work with older Macs that have built in serial ports. If you have such an older Mac,
you will need to get a USB to Serial adaptor to make a direct serial connection to your
host.
NOTE: You must select Serial/Modem from the Connection Menu to enable serial
ports.
Otherwise, the Serial Ports selection under the Settings Menu will be "Serial/Modem
Not Enabled" and all of the baud rates will be disabled.
Direct Serial Connection
MacWise has been tested with Keyspan USB to Serial adaptors.
www.keyspan.com
Built in Modem
Automatically supported by MacWise.
You may need to enter a Modem Initialization String to make your modem dial and
connect to your host.
Consult your user's manual for the modem that came with your Mac.
You can try one of the preset init strings. One of them will probably work.
Keyspan USB to Serial Adaptors and drivers
You will need to install the OS X drivers for Keyspan if you are using one of these
devices.
They are available at
http://www.keyspan.com/products/usb/usa28x/downloads/#MacXLatest
—————————————————————————————————————————————————————
————————————————————————————

Preferences

Remember Window Positions and size - MacWise will remember the size and
position of your MacWise window when you close the window or quit and
restart MacWise.
Limit Screen Page Depth to 24 Lines - Some host programs require the screen
to scroll when the cursor is below the 24th line. If you are experiencing
improper scrolling, then enable this option.
Disable this option if you have a large monitor and want full page scrolling.
Also, See "Previous Page Options" under the Edit menu for scrolling options.
Warn User When Option - C Will Close the Connection - If the user presses
Option - C on the keyboard, it will warn them that the connection is about to
close.
Xymox Wyse 370 Mode - This is specifically for users of host software by
Xymox, AKA Metropolis. It enables special Option Keys. Do not enable this
option unless you are connecting to one of these hosts.
Please read the file, "Xymox / Metropolis ReadMe"
http://www.macwise.com/Misc_Help_Files.zip
Use Keypad for Wyse 60 Edit Keys - This changes the configuration of the 10key pad on your keyboard. When enabled, the keys are as follows:
The top row of the keypad on the Mac has the same function as a Wyse 60
terminal...
Clear = / * becomes Ins Char, Del Char, Clr Line, Repl
With the shift key held down:
Clear = / * becomes Ins Line, Del Line, Clr Scrn, Ins
Allow Host to Enable Ansi Colors - If the host computer sends ansi color codes
to MacWise, they will be displayed. Otherwise. MacWise will use all of the
colors you have selected in the Colors... item under the Sizes Menu.
Enable Alternate Keypad for VT Emulation - This changes the configuration of
the 10-key pad on your keyboard for VT100 and VT220 Emulation.
When enabled, the keys are as follows:
The top row of the keypad on the Mac becomes the PF keys...
Clear = / * becomes PF1, PF2, PF3, PF4
and the number keys become escape sequences.
NOTE: Alternate Keypad mode can still be enabled by the host computer when
this option is not turned on. This option just forces it to always be on.
Enter Key = Return Key - When you press the Enter key, it will be the same as
pressing the Return key.
Use SLnet options with Kermit - Special options are used when opening a

Kermit connection to a SLnet host to prevent garbage on the login screen.
NOTE: USE SLnet options with Kermit can cause problems with fkeys and arrow
keys when using VT100 or VT220 emulation.
It can also cause problems when clicking the mouse to send the column and row
to the host.
Allow Delete key to continue to line above in Half Duplex Mode - When using
half duplex mode, enable this option if you do not want the delete key to stop
at the left margin on the current line.
MOUSE CLICK OPTIONS
Clicking on a URL Link Works Only If It Is Underlined - If this is enabled, you
can only click on an underlined web address URL or email address to launch
your web browser or email program. If this option is disabled, It will launch the
app even if the address is not underlined.
For host controlled browser launching that does not require clicking, see
"Launching Your Browser and Sending Email Under Host Control"
Send Carriage Return on Single Mouse Click - When you click on a menu
number or word in the MacWise window, it will be sent to the host and a
carriage return will be sent. Otherwise, just the number or word is sent and no
carriage return.
Mouse Click Delimiter Character - The Mouse Clicks button Lets you specify
the character that immediately follows your host menu item numbers (usually a
period). This allows you to click on a menu item number without sending the
period (or whatever character you specify). Also, If you click on any word on
the screen, it will be sent to the host.
Mouse Click Sends Column,row to host
Mouse click sends its cursor position to host preceded by ESC MOUSE
(CCC,RR where C=Column and R=Row)
Example:
Mouse is clicked on column 5 row 20
MacWise sends ESC MOUSE 005,20 CR
(where ESC = ASCII decimal 27 and CR = ASCII decimal 13)
NOTE: Rows start at row zero for this function.
Click on System Builder Menus - When communicating with host computers
running System Builder software, this option lets you click on menu items
within the window to select the menu item.
Disable Mouse Clicks - When you click the mouse on text in the MacWise
window, nothing will happen if this option is enabled. However, you can still

click on the fkey buttons at the bottom of the window.
More Preferences Information
Versions of MacWise prior to version 12.5.1 stored the preferences in the user's
Preferences folder.
Settings are now stored in the user's Application Support folder.
If MacWise finds the older preferences in the Preferences folder, it will copy them to
the new location in the Application Support folder.
To find the MacWise preferences folder:
Click once on the desktop.
Hold the Option Key down and select Library from the Go Menu.
Open the Application Support folder
Open the MacWise folder
Open the MacWise Prefs folder
Now you will see at least four files that belong to MacWise:
defaults - stores most of your settings
fkeydefaults - stores your fkey settings
QuickDial - stores your QuickDial number for dialing with the modem.
Recorder - the default file to hold data you record with the capture menu.
—————————————————————————————————————————————————————
————————————————————————————

Function Keys

Function keys can be used from the keyboard or by clicking on the fkey with the
mouse.
When you change your emulation type, you will also need to change the function keys
being used.
If you are using Wyse or Viewpoint emulation, you can select "Wyse Function Keys" or
"Viewpoint Function Keys" under the Emulate Menu.
If you are using any other emulation, you will need to load the function key set. This
can be done by selecting "Function Key Sets" from the Emulate Menu. Then just
double-click on the set you want.
Function Key sets as of 5/13/2011 are:
Mac unix fkeys - Common commands for the Mac unix shell
NWMLS Fkeys - for Northwest Multiple Listing Real Estate Services and VT100
emulation
Triad TV925 Fkeys - for Triad hosts and TV925 emulation
Triad Wyse Fkeys - for Triad hosts and Wyse emulation
Viewpoint Function Keys - Standard Viewpoint fkeys
Viewpoint Fkeys W/Page Up - has page up/down fkeys for Viewpoint emulation
VT100 Fkeys - Standard VT100 emulation fkeys
VT100 MLS Fkeys - Multiple Listing Service Fkeys for VT100
VT220 Fkeys - Standard VT220 Fkeys

VT220 Fkeys W/Do Key
VT220 MLS Fkeys - Multiple Listing service Fkeys for VT220
Xymox Fkeys - for Xymox, Xytec hosts and Wyse 370 emulation
Wyse Fkeys - Standard Wyse fkeys
MacBook with Touch Bar
MacWise works with the Touch Bar.
To make the Fkeys appear in the Touch Bar, you should add MacWise to the Keyboard
System Preferences:
Select System Preferences from the Apple Menu
Click on Keyboard
Click on Shortcuts
Click on Function Keys in list on the left
Click on the + icon and navigate to MacWise in the Applications folder and select it.
If your fkeys do not work from the keyboard...
If you are using a laptop, it will have a fn key in the lower left corner of the keyboard.
You need to hold the fn key down when pressing a function key to make it work.
You can get around this by opening the Keyboard & Mouse control panel.
Select Keyboard & Mouse from the System Preferences Menu under the Apple Menu.
Click on the Keyboard tab.
There is an option that says, "Use all F1, F2, etc keys as standard function keys"
Put a check mark on that option. Now your function keys will work in MacWise.
If you want to use a function key to change screen brightness, sound, etc. then hold
down the fn key.
Keyboard Shortcuts can override MacWise function keys.
Select Keyboard from the System Preferences Menu under the Apple Menu.
Click on the Shortcuts tab. Change any function keys that conflict with the fkeys you use
in MacWise.
MacWise actually supported fkeys in the old days when there were no fkeys on Mac
keyboards.
If you do an option 1 you will get F1, Option - Shift 1 for Shiffed F1 etc.
Numbered keys from 1 thru 10 on the top row are F1 thru F10
F11 thru F16 are the qwerty keys.
Starting with MacWise version 15.2.6, You can disable this feature by selecting
"Function Key Options" under the Emulate Menu and then uncheck "Use Option Key
and Number Keys as Function Keys"
That will allow you to use the Option key with number keys to type special characters if
"Strip 8th bit" is unchecked under the Settings Menu.
Also, You can Edit all of the fkeys by selecting Edit Fkeys from the Emulate Menu.
You can move the function of a fkey from one fkey to another...
For instance, you could edit F12 and click the Copy button. Then edit another fkey that

is visible on the screen and click the Paste Key. That makes that fkey have the function
of F12.
VT220 Fkeys
For more information about VT220 function keys and special editing keys such as
Help, Do, Find, Insert, Remove and Select, refer to this web page http://
carnationsoftware.com/carnation/RSS/RSS_VT220_Fkeys.html
Wyse 60 Programmable Fkeys
For information about Wyse 60 programmable function keys, refer to this web page.
http://carnationsoftware.com/carnation/RSS/Wyse_Keys.html
—————————————————————————————————————————————————————
————————————————————————————

Arrow Keys

Select Arrow Keys... from the Emulate Menu
Normally, you will not need to change any of the arrow keys. MacWise sets them
correctly to match the emulation type you are using. However, your host may expect
to use a non-standard code for one or more keys.
In that case, you will need to find out what code your host expects to see for each
arrow key and enter that code into the Arrow Keys window.
Reset to Defaults - will reset the arrow keys to the default values of the Emulation
type currently in use.
{CT - Click on this button to insert the {CT command. Then type a capital letter after
it. For instance, {CTJ would be control J.
{ES - Click on this button to insert the {ES command. Then type a capital letter after
it. For instance, {ESJ would be escape J.
{CR - Click on this button to insert the {CR command to put a carriage return at the
end of the line.
Left Arrow = Control U ( {CTU )
Prior to MacWise 11.12, there was an option under the Emulate menu for Left Arrow =
Control U. That option has been replaced with the Arrow Keys... window which allows
you to customize any arrow key. To re-create the control U option, simply enter {CTU
in the left arrow field.
—————————————————————————————————————————————————————
————————————————————————————

Printer Setup

Select Printer Setup from the File Menu

"IGNORE CONTROL -CHARACTER PRINTER-ON COMMANDS" is normally
unchecked.
If you are using Adds Viewpoint emulation, you will probably want to turn
this back on.
It is used to turn on slave printing under host control. If this is enabled
when using Wyse emulation, you may get a print dialog box on the screen
when you are not expecting one.
"IGNORE PRINTER OFF COMMANDS FROM HOST" is only used for host
computers that send a Printer Off command for each line of text. If you
have this option enabled, you will need to manually toggle Printer On
back off to start printing. You can usually leave this option off. The newer
versions of MacWise use a timer to determine when printing is done.
"PASS CONTROL CHARACTERS TO PRINTER (DIRECT PCL PRINTING)"
allows the host to send PCL commands when slave printing. PCL
commands allow the host to select printing features such as bold text,
lines per inch, margins, etc.
This mode bypasses the standard Mac print dialog box and prints directly
to the Mac default printer.
For more information, read the document called "Printing direct with
PCL".
http://macwise.com/Printing_Direct_With_PCL_MacWise.html
Note: The default for this option is OFF. When it is unchecked, MacWise
supports slave printing but filters out all escape sequences sent to the
printer and the standard Mac printer dialog box is used.
SELECT THE PRINTER FONT AND SIZE. The default is MacWiseFont 12
which should fit 80 columns
and 66 rows on a standard letter-sized sheet of paper. If you use size 14
you will probably not be able to
fit 80 columns on a letter-sized sheet. Only Monaco, Courier and
MacWiseFont are provided since
they are non-proportional fonts (which work best for proper column
alignment).

When you select MacWiseFont, you will be able to print screens that
contain graphic drawing characters and special international characters.
Enabling this font actually selects a TrueType printer font.
If you have "Mac Set" enabled in International Characters, then
MacWisePrinterFont is used.
If you have "IBM Set 2" enabled in International Characters, then
MacWiseIBMPrinterFont is used.
MacWisePrinterFont and MacWiseIBMPrinterFont are TrueType printer
fonts.
There is no menu selection for these fonts. They are just automatically
used.
PROCESS FORM FEEDS FROM HOST (version 22 or later)
Allows the host computer to send ASCII character 12 form feeds.
When this mode is enabled, the standard Mac OSX print dialog box is
used.
However, the orientation is pre-selected in Printer Setup and therefore
not shown as an option in the print dialog box when printing under host
control.
Scaling is automatically calculated and is not an option in the print dialog
box.
Paper size is US Letter.

File Menu / Printer On
Turns the printer on. All data that comes to the screen will be printed. Printing does
not start until Printer On is turned off. You can toggle Printer On and Off with
COMMAND =. The host computer can also send commands to your Mac to toggle
the printer on and off.
Direct PCL printing is not supported in this manual printing mode.
—————————————————————————————————————————————————————
————————————————————————————

Window Menu

Maintains a list of open windows and lets you select a window to activate.
Enter Full Screen
Full screen mode makes the MacWise window take up the full screen.
The menu bar disappears and can be made visible by moving the mouse to the top of
the screen.
To enter Full Screen mode, select "Enter Full Screen" from the Window Menu.
To exit Full Screen mode, select "Exit Full Screen" from the Window Menu
You may notice that the escape key is used in many full screen apps to exit full screen
mode. However, the escape key is used for many other functions in MacWise and
therefore cannot be used to exit full screen mode.
Note: If you are using a MacBook Air or MacBook Pro with a 1280 X 800 screen, the Full
Screen mode is very useful because you can use the 24-point font and large window to
fill the entire screen including the function keys at the bottom of the screen. You can
use a three-finger swipe (left or right) on your trackpad to switch from the MacWise
full screen back to the desktop or to other full screen windows. You can also use
Control-Left arrow and Control-Right arrow to switch.
—————————————————————————————————————————————————————
————————————————————————————

Sizes Menu
Screen and Font Sizes
You can change the window and font size by selecting several different window sizes
from the Sizes Menu:
20-Point Font and Larger Window
24-Point Font and Largest Window
36-Point Font and Largest Window
132 and 160 Column Screens
When you select a window size, the correct font size will be selected for 132 or 160
column mode.
Window Height
You can drag the lower right corner of the window to make the window taller.

If you are communicating directly with the Mac unix shell, the number of lines
displayed will
increase beyond the standard 24 lines (see that option in Preferences). If you are
connected
to another host computer, the number of lines displayed may or may not increase
beyond 24
depending upon the setup of the host computer.
NOTES:
SCO ANSI MODE - Requires a 25 line screen instead of 24 lines. When you select SCO
ANSI from the Emulate Menu, the screen hight will automatically change to 25 lines.

MacWise Fonts
No font installation is required.
MacWise 22.1.2 or later installs fonts each time MacWise is run.
(Previous versions required you to manually install fonts with the MacWise
Installer.)
Several fonts are installed when MacWise is run.
They are located in /Library/Fonts/MacWise Fonts
MacWiseFont.nfnt (not used but provided for backwards compatibility when older 32bit versions of MacWise are used).
Seven TrueType screen fonts:
MacWiseNewFont-21.ttf
MacWiseIBMNewFont-21.ttf
MacWiseNewFont.ttf
MacWiseIBMNewFont.ttf
MacWiseFontSerif.ttf
MacWiseIBMFontSerif.ttf
MacWiseUnicodeFont.ttf
You can select from three different fonts under the Sizes Menu:
MacWise 2021 Font
MacWise Font
MacWise Serif Font
If the IBM Set 2 Font is enabled in International Characters then the IBM version of the
font you select will be used.

MacWise Unicode Font is automatically used for special characters when Unicode
UTF-8 font is enabled in International Characters.
(See International Characters for more info)

MacWisePrinterFont and MacWiseIBMPrinterFont are TrueType printer fonts used
when printing.

COLORS
When "Use ANSI Colors" is enabled, the host server controls which colors are displayed
on the screen.
If that option is enabled, you will not be able to select any colors other than Normal
Text and Background.
Some hosts require the screen to be cleared to the background color and you can
enable that option.
When "use ANSI Colors" is disabled, you can select the colors you want to use for video
attributes.
( Inverse, Dim, Bold/Message and Underline )
MacWise version 22.4 or later will display the color you have selected in a colorwell.
You can select standard colors from the pull down menu or you can click on the
colorwell to choose a custom color.
Note that Normal Text and Background colors can only be changed using the pull down
menu (not by clicking on the colorwell)
—————————————————————————————————————————————————————
————————————————————————————

Multiple Session Windows

You can open up to 10 windows and connect to different host computers with each
window. With a telnet or unix connection, you can open multiple sessions to the same
host computer.
Open a new window with New Session Window under the File menu.
The window will open with the same settings as the previous window.
You can change the settings for that window and then switch between windows.
When using the serial port, you can only use one port at a time.
Only one session window is allowed when in Full Screen mode.
—————————————————————————————————————————————————————
————————————————————————————

Settings Files

MacWise always remembers the settings of the currently opened window whenever
you quit.
If you only connect to one host computer and do not use multiple session windows,
then you do not need to save settings files.
If you need to use settings files, you can save your settings (under the File menu).
Then when you want to open a settings file you can select Open Settings from the File
Menu or you can double click on a settings file from the desktop.
HINT: Save all of your settings files in one folder. Save one settings file for each host
you connect to. Then you can easily choose from the list of hosts to connect to and
just double click on the one you want. Each settings file you double click on will open
a new window with all of the associated settings for that host.
Locking Settings Files
MacWise has the capability of locking the settings files to prevent the user from
changing settings.
If you are a system administrator for a company, you may contact Carnation Software
and request the procedure for locking the settings. Send your request to
richlove@carnationsoftware.com
—————————————————————————————————————————————————————
————————————————————————————

Launching Your Browser and Sending Email Under Host
Control
When programmed into your host, you can select from a host menu item to
launch your browser and go to a web site. Or launch your mail program and
enter the recipient.
Please read the file, "Browser launching and email.rtf"
http://www.macwise.com/Misc_Help_Files.zip
—————————————————————————————————————————————————————
————————————————————————————

Data Transfers to and from the Host
Capture Files
You can capture data from the host by selecting "Make a New Capture File" from the
Capture Menu.
Any data that comes to the screen will be captured until you toggle "Capture On" back
off.

The host computer can also control data transfers by using escape sequences
recognized by MacWise.
Read the document, "MacWise Special Host-To-Mac Commands here...
http://www.macwise.com/Special_Host_to_Mac_Commands.html
Record to Clipboard
You can capture data from the host by selecting "Record to Clipboard" from the
Capture Menu. Any data that comes to the screen will be captured until you toggle
"Record to Clipboard" back off.
Host-To-Mac and Mac-To-Host File Transfers.
These are text file transfer options that were originally designed for PICK host
computers.
They also work with Universe and Unidata hosts. Read the file called "PICK Data
Transfers" for detailed instructions. http://macwise.com/
PICK%20Data%20Transfers.pdf
The Mac-To-Host File Transfer is a simple text transfer and could be used with any
host.
FTP File Transfers
FTP file transfer capability is built into the Mac Unix Shell.
You can send and receive files.
Open a New Session Window (under the File Menu)
This will be your ftp window.
Then...
1. Select Mac Unix Shell from the Connection Menu in MacWise.
2. Type ftp. You will get the ftp prompt.
3. To connect to your ftp host, type “ftp HostAddress” where HostAddress is the IP
address of your host computer.
4. Type ls to see a list of files.
5. If you need to look inside of folders use the cd command ( cd FolderName )
6. To receive a file from the host, use the get command ( get FileName )
7. To send files to the host, use the put command (put FileName )
Note 1: If you need secure ftp transfers use sftp instead of ftp.
Note 2: The host will not allow a put if you are logged in anonymously
After you receive a file to your Mac, double click on the hard drive icon and you will
see the file.

Kermit File Transfers
Select Kermit from the Connection Menu to enable Kermit file transfers.
The Kermit installer will run if you have never installed Kermit.

Close the MacWise connection and re-open it. You will automatically log in using Kermit.
MacWise supports Kermit for telnet, ssh secure shell and Mac Unix Shell connections.
Kermit Data transfers will not work with Unix Raw Mode enabled. If you select Kermit
from the Emulate Menu, Unix Raw Mode will become unchecked in the Telnet
Connections... window.
Receiving a File from the Host
If the host sends a file to you using the Kermit file transfer protocol, the file will be
transfered to your kermit_transfers folder in your documents folder
(~documents/kermit_transfers)
The nice thing about Kermit file transfers is that files are received automatically with no
operator intervention.
Just look in your kermit_transfers folder for any files transferred.
NOTE: If you are using Accuterm commands to transfer files, then files with the same
name will be overwritten.
Kermit will automatically name the file ft.txt if it is a text file.
Each time you do a transfer from the host to your Mac, you will need to move or rename
the existing file if you do not want it to be overwritten with the new file transfer.
Send a Kermit File to the host
1. Drag the file you want to send into the kermit_transfers folder in your documents
folder on the Mac.
2. Log into your host as you normally would with Telnet or Secure Shell
3. Break into the kermit command line on your host with whatever command your host
uses.
4. type kermit - r (or kermit receive)
5. Break into Kermit command line on the Mac with Control \ c
type c)

(That's Control \

then

6. Now you should be at ~/Documents/kermit_transfers/) C-Kermit
7. Type ls and you should see the file you want to send in the directory listing (just to
confirm it is there)
8. Type send MyFile.txt (where MyFile.txt is the file you want to send)

9. Exit out of your host kermit command line (usually by typing exit)

NOTE: If you get a Warning message during the file transfer stating that your terminal
type is not recognized, you will need to change the terminal type that you have entered
into the Telnet Connection... window under the Connection Menu. If Kermit does not
recognize your terminal type, it will close your connection and exit into the unix shell the
second time you do a kermit transfer.
Standard terminal types to use are:
Emulation
TERM type
Prism
prism7
TV925
tvi925
VT100
vt100
VT220
vt220
Viewpoint
viewpoint
Wyse 50
wy50
Wyse 60
wy60
Wyse 370
wy370
If you are using anything other than vt100, vt220 or wy50, you will need to install
extra terminfo files on your Mac.
Please read the file called "terminfo installation instuctions.rtf".
http://www.macwise.com/terminfo_for_MacWise.zip
Also, read "Kermit and MacWise"
http://macwise.com/Kermit_and_MacWise.html
For more information about Kermit
http://www.columbia.edu/kermit/ck80.html
MacWise supports AccuTerm commands for Kermit file transfers.
See the help file, AccuTerm Supported Escape Sequences
—————————————————————————————————————————————————————
————————————————————————————

International Characters
International Characters (under the Emulate Menu) are special characters that are
used in different countries around the world. The default setting is US ASCII / Mac Set
and is used in the United States.
An example of special characters: ∫ ø ¨å Æ £ ¿
If you have the Mac Set selected in combination with any of the foreign countries then

the special characters are 7-bit characters and use the National Replacement
Character Set (NRCS)
If you have the IBM Set 2 selected in combination with any of the countries, then the
special characters are 8-bit characters and the country selected is ignored.
The exception to this is the French / Canadian setting which allows you to use 8-bit
mode
Wyse Multinational is used for Wyse graphic drawing lines.
DEC Multinational is used for DEC graphic drawing lines in 8-bit mode with the IBM
Set.
Unicode
As of MacWise version 21, there is an option for Unicode Characters.
MacWise will process decimal character strings that represent UTF-8 unicode
characters.
Selecting this option will uncheck Strip 8th bit.
The host needs to be in NLS mode to send the correct character sequences.
For instance sending this decimal sequence from the host to MacWise displays a
trademark symbol
PRINT CHAR(226):CHAR(132):CHAR(162):
Graphic Drawing Line Characters
Graphic characters are used to draw boxes around text areas.
If graphic characters do not work and display letters like D, Z or H instead of the
graphic characters...
There are several possibilities why it is not working.
First, try unchecking Strip 8th Bit and then use IBM Set2 as your font set.
If that does not work, there are two other options for graphic characters (DEC or Wyse
Multinational characters).
You will just need to experiment with different settings.
Strip 8th Bit (under the Setings Menu)
When this option is enabled, communication with the host is done using 7-bit
characters.
(the 8th bit is stripped off).
Normally, if you use IBM Set2 you do not strip 8th bit.
Wyse Multinational is usually used with 8th bit stripped.
DEC Multinational must be used with the 8th bit not stripped.
—————————————————————————————————————————————————————
————————————————————————————

Screen Saves and Restores

Many host computers are programmed to instruct the client app to save and restore
screens.
MacWise 12.0 or later supports three sets of escape sequences commonly used by PC
clients
(HostAccess, Accuterm and System Builder).
The client app is responsible for storing the screens (MacWise, in this case). This was
originally done back in the days of slow serial connections because it was much faster
for the client to display stored screens instead of the host resending them to the client
app.
But that legacy code remains on host computers and therefore needs to be supported.
MacWise version 12.0 supports up to 13 screen levels (also called slots, stacks or
blocks).
See the file, "Saving and Restoring Screens" for more information.
http://macwise.com/Saving_and_Restoring_Screens.html
—————————————————————————————————————————————————————
————————————————————————————

Displaying Pictures
MacWise can display pictures using Accuterm escape sequences.
See the file, "Accuterm Supported Escape Sequences"
http://macwise.com/Accuterm_Supported_Escape_Sequences.html
—————————————————————————————————————————————————————
————————————————————————————

Miscellaneous
Caps Lock
When Caps Lock is enabled under the Emulate Menu, all characters typed will be in
upper case.
If the Caps Lock key is on while this is enabled, characters will be typed in lower
case.
Clipboard
If "Rectangular Marquee" is checked under the Capture Menu, then dragging the mouse
will use a rectangle to define the copy area.
When you release the mouse, the text that you lassoed will be copied to the
clipboard.
Note that you cannot copy scrolled back data in this mode.

If "Rectangular Marquee" is un-checked, then the standard method of copying text to
the clipboard is enabled.
If you hold down the Command Key while dragging the mouse, it reverses the
Rectangular Marquee.
Open Connection and Close Connection
When the connection to the host is open, there will be a large dot in the title of the
window.
For instance it might say "MacWise using modem •"
If the connection is closed it will look like this "MacWise using modem ≠"
You can open and close the connection from the Connection menu or just use the
keyboard.
Option O to open the connection or just hit return.
Option C to close the connection
Connection Scripts
You can optionally use connection scripts to log into your host and enter the account
and password automatically. When you open a connection,
the Open Connection Script will be sent to the host. When you close the connection,
the Close Connection Script will be sent.
Open Connection Script - When opening a connection, MacWise waits for a
prompt from the host before sending the script. You can specify what the prompt is
by entering it into the edit field called "Wait for text before sending Open Connection
Script".
You enter the actual script that gets sent to the host by clicking on the button called
"Edit the Open Connection Script". The edit window is the same format used for
editing function keys.
Close Connection Script - When closing a connection, MacWise optionally
sends a script to the host. It does not wait for a prompt from the host. You enter the
actual script that gets sent to the host by clicking on the button called "Edit the
Close Connection Script". The edit window is the same format used for editing
function keys. If you do not want a script sent, then just make sure the script is
blank when you edit it.
Answer Back
Some host computers require an answer back message when making a connection.
This is normally done for security reasons. If the host does not receive the proper
response when the connection is opened, the host will reject the connection.
You can program an answer back in MacWise by using Connection Scripts.
The connection script is sent to the host immediately after the connection is opened.
You will need to find out what answer back message your host expects and then enter

it into the MacWise connection script.
1. Select Connection Scripts from the Connection Menu.
2. Put a check mark on "Enable Scripts"
3. Click on the "Edit the Open Connection Script" button.
4. Enter the answer back message. The message can be normal text and can also
contain control and escape sequences. Normally, the message will end with a carriage
return. Click the CR button for carriage return.
Insert Key
Press the Option key and i key simultaneously for the insert key (Option i)
You can also use Option Shift i but it does the same thing.
Older Mac keyboards had a Help key and that key works as an insert key also.
Note that VT100 does not use an insert key.
Option Keys for System Delimiter Characters
System Delimiter characters are used by programmers or system managers using the
Host editor. You can type System Delimiter characters on your Macintosh keyboard by
holding down the Option key and one of the following letter keys.
Option Key Delimiter
B
S
V
A
G

Start Buffer
Subvalue Mark
Value Mark
Attribute Mark
Segment Mark

Character
[
\
]
^
_

Decimal ASCII Code Sent to Host
27
28
29
30
31

Note: The value mark sends a Control [ to the host. This can conflict with the telnet
escape character and cause an escape back to TELNET command mode. To get around
this problem, you can change the telnet escape character to something else in the
Telnet Connection... item under the Connection Menu.
Keep TCP Connections Alive
This option is found under the Special Menu.
Many hosts have a timeout period which detects idle time. If the host does not see
any keystrokes from you for a specified amount of time (determined by the host), the
host will close the connection. This can become a nuisance for some users who want
their connections to remain open.
MacWise lets you specify a keep-alive time on your Mac. This does not change the idle
time specified by the host. It just attempts to tell the host that you are still using the

connection.
Note that if you reboot your Mac, you will need to re-enter the keep-alive time.
Also, checking the Unix Raw mode option in the Telnet Connection item under the
Connection Menu may keep the connection from closing during idle time with some
hosts.

English / French Localization
MacWise can use English or French Menus and Dialog Boxes.
It automatically uses the Preferred language that is in your Language and Regions
Preferences in OS X.
The manual has not been converted to French yet.
French Translation by Alain Pastor.
Special MacWise Commands - Beyond Terminal Emulation
—————————————————————————————————————————————————————
————————————————————————————
Note: AccuTerm, HostAccess and System Builder are trademarks of their
respective companies and are not associated with Carnation Software.
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